
 මලක ොතොරතර

1.    හනතොන යන කමක ද? 

2. Fedora   යන කමක ද? 

3.   ොමොකකද ොම ගන/  ලනකස (GNU/Linux) 

4.   සජව තැටයක (LiveCD/DVD) යන? 

5.  හනතොන සථොවර(stable)   ොමොහයම පදධතයක ද?      නැතනම අතහදොබැලම මටටොම තොබන පදධතයක ද? 

6.          හනතොන වෘතතය ොහොෝ කොරයොලය පරසරයක භොවත කරනන මට පළවන ද? 

7.          මො සමග කොරයොලොය වැඩ කරන අනත අය භොවත කරනොන Windows  ොමොහයම පදධතයය.  මො පමණක 

        හනතොන භොවතයට ොයොම වොමන මට අවොසයක සද ොවය ද?        මො නපදවන ලප ොගොන ආදය වවෘත කරමට හො 
     කයවමට අනත අයට බැර ොවය ද? 

8.     හනතොන සහ ොෆොඩොරො අතර ොවනස 

9.      හනතොන භොවතොයද කල ඉකත වමක සදවනවොද? 

10.    සථොපනයට අනකමක අංක (  සරයල අංක)  අවශ් ද? 

11.     මෘදකොංග යොවතකොල කළ හැක ද? 

12.     හනතොන තැටයක වකණම මල කයද? 

13.      මොග කොඩ හනතොන වකණය හැක ද?        ඒ සඳහො මො ොකොපමණ මදලක ොගවය යත ද? 

14.     හනතොන ව්ොපෘතයට අධොර අවශ් ඇය? 

15.        හනතොන තැට පටපත කර මතරන අතර ොබදොහැරමට හැකද? 

16.      දැනට ඇත අලතම හනතොන නකතව කමකද? 

17.        හනතොන අලත ොවළමක නකත කරනොන ොකොපමණ කොලයකට පසද? 

18.   මළඟ නකතව කමකද? 

19.     හනතොන සමඟ ලැොබන මෘදකොංග ොමොනවද? 

20.      හනතොන භොවත කළොම උබනට භොවතයට අපහසද? 

21.      හනතොන මත සංහල සථොපනය කළ යතද? 

22.   හනතොන මත mp3, mp4, avi    වොදනය කළ හැක ද? 

23.   හනතොන සදහො skype   සථොපනය කළ හැකද? 

24.    හනතොන සමඟ එන LibreOffice  වල Office2007     ොගොන වවෘත කළ හැක ද? 

25. MS Windows        සමඟ හනතොන එකම පරගණකොය සථොපනය කළ හැක ද?    එමගන පරගණකොය ොවගය අඩ 

 ොවවද ? 

26.    ෛවරසගොඩ එකක අවශ් ද? 

27.      මොග ොඩොංගල එොකන ඉනටොනට යනන Mobile Partner   සථොපනය කරනන ඕනද?   ඒ ොවනවට ොවන 

 වසදමක තොයනවද? 

28.       හනතොන ලනකස තයන ගැටල වසඳො ගනොන ොකොොහොමද? 

29.              මට ඊොමල ොගොඩක එන එක කරදරය හනතොන අඩවොය අලත ොතොරතර පමණක ගනන කමයක නැදද? 

30.       මට හනතොන ව්ොපෘතයට සහොය වය හැක ද? 

සථොපනය

1.         හනතොන සථොපනය කරගනන අවශ් අවම දෘඪොංග පහසකම ොමොනවො ද? 

2.    හනතොන ගනොන ොකොොහොම ද? 

3.   හනතොන බට 64   පරගණක මත (AMD-64  ොහොෝ Intel-64)   කයොතමක කළ හැකද? 

4.    හනතොන සථොපනය කරනොන ොකොොහොමද? 

5.       ොකොොහොමද හනතොන ඩවල බට ොලස දොනොන
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6.  මොග NTFS (Windows NT/2000/XP/2003)   පොටශන බලොගනොන ොකොොහොමද? 

Desktop සැකසම

1. Desktop Effects /     ොඩසකොටොප රංගසැරසල සකය කරනොන ොකොොහොමද? 

2.   මොග පරගණකොය Desktop Effects  වැඩකරනොන නෑ. 
3.   පරගණකය වසොදමනොන ොකොොහොමද? Shutdown    තොබන තැන ොහොයොගනන බෑ. 

  කොරයොලය ොයදම

1.    හනතොන එොක තොයන LibreOffice     වලන ලයමක ලයලො මම MS Office  තොයන පරගණකයකට 

 ොගනයනොන ොකොොහොමද? 

2.  ලයමක PDF    බවට පත කරගනන පළවනද? 

3. LibreOffice වතරද?  ඇය OpenOffice.org නැදද? 

4.   සංහොලන ලයනොන ොකොොහොමද? 

5.      සංහොලන ලයනන මම ොෆොනට දොගනන ඕනද?
6. LibreOffice    මත සංහල අකර bold    කළ වට ොකොට එනව, "ශ"    වැන අකර ලයොවනොන "ශර" ොලස. 

  ොකොොහොමද හදො ගනොන? 

 මෘදකොංග කළමනොකරණය

1.       හනතොන මත මෘදකොංගයක සථොපනය කරනොන ොකොොහොමද ? 

2.         හනතොන තළ ඇත මෘදකොංග යොවත කොල කරනොන ොකොොහොම ද? 

3.       හනතොන තළ ඇත මෘදකොංග ඉවත කරනොන ොකොොහොමද? 

4.   හනතොන තළ exe     ොගොන සථොපනය කළ හැකද ?  ොකොොහොමද කරනොන? 

 ජොල සැකසම

1.  පරගණකොය IP      ලපනය සහ අොනකත ොතොරතර ොදනොන ොකොොහොමද? 

2.  මොග Dongle     එොකන අනතරජොලයට යනොන ොකොොහොම ද? 

3.    හනතොන ලනකස සථොපනය කළො,    නමත අනතරජොලයට පවොසනන බැ 
4.    මොග අනතරජොල ොසවොදොයකයොොග (ISP) DNS  දැනගනොන ොකොොහොමද? 

 පරශලක කළමනොකරණය

1.   මොග මරපදය (password)    ොවනස කරගනොන ොකොොහොම ද? 

2.       හනතොන මත අලතත ගණමක හදනොන ොකොොහොමද ? 

3.       හනතොන තළ ඇත ගණමක මකනොන ොකොොහොම ද? 

4.       හනතොන තළ ඇත ගණමක ොවනස කරනොන ොකොොහොමද? 
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 ආරකක සැකසම

1.   ොමොකකද ොම SELinux? 

2. SELinux      නසො මොග එදොනදො කටයතවලට කමක ොවයද? 

3. SELinux සකය/    අකය කරනොන ොකොොහොමද ? 

  ජංගම දරකථන සැකසම

1.   මොග ජංගම දරකථනොය/   ොඩොංගලොය ඇත SMS  සහ Contacts     මට හනතොන මතද බලොගත හැකද? 

ොවනත

1.   හනතොන ලනකසහ touch pad tapping   වැඩ කරනොන නෑ.    ඒක හදො ගනොන ොකොොහොමද? 

2.       මොග හොඩ ඩසක එොක ඉඩ බලොගනොන ොකොොහොමද? 

3.  අනතරජොල ොවගය, CPU, Memory   භොවතය බලොගනොන ොකොොහොමද? 

4.       ඩසක එොක තොයන ෆයල එකක ොහොයොගනොන ොකොොහොමද? 

5.       ලනකසහ වධොනයක පළබඳ වැඩ වසතර ොසොයොගනොන ොකොසද? 

6.      හනතොන සංහල අතර මහණතට පවොසනොන ොකොොහොමද? 

7. terminal   යන කමක ද? 

8. root   යන කමක ද? 

 මලක ොතොරතර

1. හ    නතොන යන කමක ද? 

            හනතොන ලනකස යන ශ ලොංකක පරගණක පරශලකයොට වඩොත උචත වන අයරන සපකට Fedora ොමොහයම 
      පදධතය ොවනස කර සැකස පරගණක ොමොහයම පදධතයක.     ොමය ොනොමොල ොබදොහරන ලබන අතර 

        සමොවකන ොතොර ව නැවත නැවතත ොබදොහැරමට සමපරණ නදහස සහතය.   ොවනත වචනවලන කයොතොත 
     ොමය නදහස හො වවෘත ොමොහයම පදධතයක.         සජව තැටයක ොලස ොමය නරමොණය කර ඇත නසො සථොපනය 

         කරොමන ොතොරව ොමම ොමොහයම පදධතය භොවත කර බැලොම හැකයොව තොබනවො. 

ඉහළට

2. Fedora   යන කමක ද? 

Fedora  යන Red Hat           සමොගොම අනගහය ඇතව පජොව වසන දයණ කරන ලද ලනකස ොමොහයම පදධතයක. 
            ොමය ොනොමොල ලබොගත හැක අතර සැමවටකම පොොහ අොනකත ලනකස ොබදොහැරම වලට පථම නවතම 

     තොකෂණක වරධනයන නදහස මෘදකොංග ොලොවට මදොහරනවො. Fedora    ොමොහයම පදධතොය අලත ොවළමක 
      සෑම මොස හයකට පමණ වරක නකත ොවනවො. 

ඉහළට

3.   ොමොකකද ොම ගන/  ලනකස (GNU/Linux) 

 ගන (GNU - GNU is Not Unix)      කයනොන සමපරණොයනම නදහස මෘදකොංග වලන Unix  ොමොහයම පදධතයට 
       සමොන ොමොහයම පදධතයක සංවරධනය කරමට දයත කළ ව්ොපෘතයක.   ොමම ව්ොපෘතයට වැඩසටහන 

(applications),  පසතකොල (libraries)        සහ සංවරධක මෘදකොංග වොග මෘදකොංග සමහයක අඩංග ොවනවො. ලනකස 
(Linux)          කයල හඳනවනොන සමපත කළමනොකරණයට සහ දෘඪොංග සමඟ ගනොදන කරනන පළවන 
මෘදකොංගයක.          ොම ොකොටස ොදකම එනම ගන සහ ලනකස එකතොවලො තමය ගන/   ලනකස හැදල තොයනොන. 

             අද අප නකනම ලනකස කයල කවවට ඇතතටම ොම ොබොොහොෝ පදධතන නයම වදයට හඳනවනන ඕන 
ගන/   ලනකස යනනමන. 
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ඉහළට

4.   සජව තැටයක (LiveCD/DVD) යන? 

          සථොපනය කරමකන ොතොරව ොමොහයම පදධතයක ධොවනය කළ හැක ආකොරයට සැකස CD/DVD තැටයක 
   සජව තැටයක වශොයන හැඳනොවනවො.       උදොගරණයක ොලස ඔබොග පරගණකොය සථොපනය කර ඇත 

           ොමොහයම පදධත එොසම තබයද සජව තැටයක ඇත ොමොහයම පදධතයක ොයොදොගනමන පරගණකය පණ 
       ගනවො ඒ බොහර ොමොහයම පදධතය පොවචච කළ හැකය. 

ඉහළට

5.  හනතොන සථොවර(stable)   ොමොහයම පදධතයක ද?      නැතනම අතහදොබැලම මටටොම තොබන පදධතයක ද? 

   හනතොන සථොවර ොමොහයම පදධතයක.         එය ොෆොඩොෝරො ොමොහයම පදධතය පොදක කරොගන තොබන නසො එහ 
   තොබන සයල ම වොස,       ආරකෂොව සහ ශකතන ොමහ ද ඇතළත ොවනවො. 

ඉහළට

6.          හනතොන වෘතතය ොහොෝ කොරයොලය පරසරයක භොවත කරනන මට පළවන ද? 

  අනවොරයොයන ම පළවන. 

ඉහළට

7.          මො සමග කොරයොලොය වැඩ කරන අනත අය භොවත කරනොන Windows  ොමොහයම පදධතයය.  මො පමණක 
        හනතොන භොවතයට ොයොම වොමන මට අවොසයක සද ොවය ද?        මො නපදවන ලප ොගොන ආදය වවෘත කරමට හො 
     කයවමට අනත අයට බැර ොවය ද? 

      ඔබට කස ම පශනයක ඇත ොවනොන නැහැ.      ඔබ හනතොන ලනකස තළ නපදවන ලපොලඛන,  ගැෆක ොහොෝ 
            ොවනත ොගොන ඕනෑ ම ොමොහයම පදධතයක තළ වවෘත ොකොට කයවමටත නැවත සැකසමටත පළවන. ඊට 
    අමතරව පරගණක ජොලයක හරහො ොබදොගනනටත,   මදණය කරගනනටත හැකය.  ඔොබ කොරයොලය 

      කටයතවලට ොමයන අනස බලපෑමක සද ොවනොන නැහැ.        මෘදකොංග සඳහො යන වයදම නතර වම නසො ඔබට 
    වශොල වොසයක නම අත ොවනවො.          ොම පළබඳ වැඩ වසතර සඳහො හනතොන ලනකස ගණොංග පටව බලනන. 

ඉහළට

8.     හනතොන සහ ොෆොඩොරො අතර ොවනස 

             හනතොන හො ොෆොඩොෝරො ගත කල හනතොන ලනකස බහමොධ් ොයදම සඳහො අවශ් ොෆොඩොරො සමඟ නකත 
   ොනොකර පැොකජ එකතවක ඇත.        ොෆොඩොරො නකතවක සෑම මොස හයකට වරක නකත ොවනවො.  ොමහද ඔබ 

            යමකස ොෆොඩොෝරො නකතවක අදොල නකත දනයට මොස කහපයකට පස ලබො ගතතද ලැොබන iso  ොගොනව තල 
     අඩංගවනොන මල නකතොව අඩංග පැොකජ පමණ.     නමත හනතොන නකතවට අදොල iso   ොගොනව වරන වර 

         නෂපොදනය කරන බැවන අදොළ දනට නයමත යොවත කරමද ොමම CD/DVD iso   තැටය සමඟන ලැොබනවො. 

ඉහළට

9.      හනතොන භොවතොයද කල ඉකත වමක සදවනවොද? 

නැහැ.          ඒත ඔබට අවශ්ය නම අොප නවතම නකතව සථොපනය කරගනන පළවන. 

ඉහළට

10.    සථොපනයට අනකමක අංක (  සරයල අංක)  අවශ් ද? 

නැහැ.    ඒ කසවක අවශ් නෑ. 

ඉහළට

11.     මෘදකොංග යොවතකොල කළ හැක ද? 

ඔව. ඔව.             හනතොන එක නකතවක සථොපනය කළ පස අවරදදක පරො මෘදකොංගවල අලත වම ඔබට ලැොබනවො. 
      ඒවො ඔොබ කැමැතොත පරද එක කරගනන පළවන.      ඔොබ පරගණකය අනතරජොලයට සමබනධව තොබ නම 
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   ඔබට ොමනව මඟන Activities > Applications System Tools > Software Update    ඔසොස ොහොෝ ටරමනලය මත 
su -c ‘yum update’  ොහොෝ su -c ‘pkcon update’  වධොනය (       හො අවශ් ඕනෑ ම වටක ද root  පරශලකොග අවසර 
පදය)      ලබො ද මෘදකොංග යොවතකොල කළ හැකය. 

ඉහළට

12.     හනතොන තැටයක වකණම මල කයද? 

ොනොමොල!            හනතොන ොවබ අඩවය හරහො ොහොෝ ඔොබ මතරක සත පටපත ොනොමොල ලබොගත හැකය. 

ඉහළට

13.      මොග කොඩ හනතොන වකණය හැක ද?        ඒ සඳහො මො ොකොපමණ මදලක ොගවය යත ද? 

ඔව!      ඔබට හනතොන සජව තැට වකණය හැකය.        ඒ සඳහො අපට කසද ොගවමක කරම අනවොරය නෑ.  ඔබට හැක 
         නම ොමම ව්ොපෘතයට දොයක වමක හැටයට සලකො අධොර කළ හැකය.    ඔබට පොරොභොෝගකයනට දැරය හැක 

       සොධොරණ මලකට අොලව කරම සඳහො අවසර තොයනවො

ඉහළට

14.     හනතොන ව්ොපෘතයට අධොර අවශ් ඇය? 

            අප ොම ව්ොපෘතය දයත කරනොන මල්මය ලොභයක අතපත කරගැනොම අරමණකන ොතොරව හොදක සමොජය 
 ොමොහවරක හැටයටය.     නමත අොප ොඩොොමන නොම සඳහොය,   සරවර පවතවොොගන යොමට,  ොපොසටර මදණයට 

               හො වැඩසටහනවල ද සසනට ොනොමොල සජව තැට සහ සටහන ොබදො දමට මදල වයදම කරම අවශ් ොවනවො. 

ඉහළට

15.        හනතොන තැට පටපත කර මතරන අතර ොබදොහැරමට හැකද? 

                 හනතොන ඔබ අතට පත වනොය සපරො ම ොනොමොල හො නදහස ව බැවන එය පටපත කරමට හො අනයයන සමග 
    ොබදොහදොගැනමට ඔබට සමපරණ නදහස හමය.      එොස කරන ොමන අප ඔබව දරගනවනවො! 

ඉහළට

16.      දැනට ඇත අලතම හනතොන නකතව කමකද? 

15.1 

ඉහළට

17.        හනතොන අලත ොවළමක නකත කරනොන ොකොපමණ කොලයකට පසද? 

Fedora            ොමොහයම පදධතොය අලත නකතවකන ටක කලකට පස ඊට අනරප හනතොන ොවළම නකත 
කරනවො.          එම නකත කරන දනය ොතක සයල යොවතකොල එයට ඇතළත ොවනවො. 

ඉහළට

18.   මළඟ නකතව කමකද? 

 හනතොන 16 

ඉහළට

19.     හනතොන සමඟ ලැොබන මෘදකොංග ොමොනවද? 

  ඔබොග එදොනදො වැඩ,            කොරයොලය වැඩ සහ ගැෆක නරමොණ සහ කමොලඛනය ආද වොශෂ කොරයන ඉට කර 
        ගැනමට ොයොෝග් මෘදකොංග ඔබට හනතොන නකතව සමඟ ොනොමොල ලැොබනවො.   හනතොන තළ අඩංග 

    මෘදකොංගවල සමපරණ ලැයසතවක සඳහො http://hanthana.org/features.php බලනන. 

ඉහළට
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20.      උබනට භොවත කළොම හනතොන භොවතයට අපහසද? 

  හනතොන යන Fedora      ලනකස නකතව මත පදනමව ොමොහයම පදධතයක. Ubuntu  සහ Fedora  යන ොවනස 
     ආයතන ොදකකන නපදොවන ොමොහයම පදධත ොදකක.   උදොහරණයක ොලස Ford  ආයතනොයන නපදවන 

Fiesta   මොදලොය සහ Nissan   ආයතනොයන නපදවන Micra       මොදලොය කොර රථ ොදකක සංසංදනය කර බලම. 
              වොහන ොදකම ොවගය පහසකම සහ ඉඩකඩ ආසනන ොලස එකොනකට සමොන වවත ඇතළත සහ පටත ොපනම 

  සළ වශොයන ොවනස.   ොම ආකොරයට Ubuntu  සහ Fedora       අතර සළ සළ ොවනසකම දකනන ලැබණත එක 
           මොදලයක වොහනයක පැදව අොයකට ොවනත වොහනයක භොවතයට ඉකමනන හරොවන ොලස අවශ් වටක 

        එකකන අනකට ඉකමනන සහ පහසොවන මොර වමට හැකයොව ලැොබනවො.  තවද Fedora   යන ඉතො ඉකමනන 
      පරශශලකයන ොවත නවතම ගණොංග ලබො ොදන නකතවක. Fedora     පදධතය වඩො පහසවන ොලස සැකස 

         හනතොන භොවතය උබනට භොවත කළ අොයකට ඉතො පහස ොවනවො ොනොනමොනය. 

ඉහළට

21.      හනතොන මත සංහල සථොපනය කළ යතද? 

නෑත.             හනතොන ොපරනමොයනම සංහල හො ොදමල භොෂොවනට යනොකොෝඩ සහය දකවන නසො අලතන සංහල 
   සථොනය කරනන අවශ් නැහැ. 

ඉහළට

22.   හනතොන මත mp3, mp4, avi    වොදනය කළ හැක ද? 

         ඔව හනතොන ොපරනමොයනම ොබොොහොෝ බහමොධ් ොගොන වරග සඳහො සහොය දකවනවො.   හනතොන සථොපනය 
       කළ වහො ම ඔබට ඒවො වොදනය කළ හැකය. 

ඉහළට

23.   හනතොන සදහො skype   සථොපනය කළ හැකද? 

  හනතොන සමඟන skype  ොපරනමොයනම ලැොබනවො.     අමතොවන සථොපනය කරනන ොදයක නැහැ. 

ඉහළට

24.    හනතොන සමඟ එන LibreOffice  වල Office2007     ොගොන වවෘත කළ හැක ද? 

    ඔව හනතොන මත දැනට OfficeXP, Office2003  සහ Office2007      ොගොන වවෘත කරමට පහසකම සහ OfficeXP, 
Office2003  සහ Office2007          මඟන යළ වවෘත කරමට හැකවන ොලස සරකොම පහසකම ද තොයනවො. 

ඉහළට

25.MS Windows        සමඟ හනතොන එකම පරගණකොය සථොපනය කළ හැක ද?    එමගන පරගණකොය ොවගය අඩ 
 ොවවද ? 

ඔව,    හනතොන කලන MS Windows       සථොපනය කළ පරගණකය සථොපනය කළ හැකය.   ොමය හඳනවනොන 
  දවතව සථොපන (dual boot) නමන.     අොනක ොමොහයම පදධතය MS Windows    හැර ොවනත එකක ොවනනත 

පළවන.           දවතව සථොපනය සද කරම පළබඳ වැඩ වසතර සඳහො සථොපන සටහන බලනන. 

      ොමහ ද පරගණකොය ොවගයට බලපෑමක ොවනොන නැහැ.      දවතව සථොපනයක කර ඇත අවසථොවක 
   පරගණකය ආරමභ කරොමද (booting)          ඔබට භොවත කරමට අවශ් කමන ොමොහයම පදධතය ද යනන ඔොබන 

වමසනවො.        වරකට කයොතමක වනොන එක ොමොහයම පදධතයක පමණය.      ොමහ ද බලපොන එකම සොධකය 
             වනොන ොමොහයම පදධත ොදක සඳහො පමොණවත ඉඩක ඔොබ හොඩ ඩසක එක තළ තබය තබමය. 

ඉහළට

26.    ෛවරසගොඩ එකක අවශ් ද? 

 අත්වශ් නැහැ.           ලනකස ොමොහයම පදධතවලටෛවරස මඟන සදවන හොන අොනක ොමොහයම පදධත වලට 
  සොොපකෂව ඉතොමත අඩය.   පසගය වසර 18         ක කොලය තළ ලනකස කරනලයට බලපෑ හැක ආකොරොයෛවරස 

     නකත වොණ අොත ඇඟල ගණනටත අඩොවන. 

ඉහළට
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27.      මොග ොඩොංගල එොකන ඉනටොනට යනන Mobile Partner   සථොපනය කරනන ඕනද?   ඒ ොවනවට ොවන 
 වසදමක තොයනවද? 

   සථොපනය කරනන අවශ් නැහැ,       ොඩොංගල එක පරණකයට සමබනධ කළ සැනන Network Manager  වසන එය 
 සවයංකයව හඳනොගනනවො. 

ඉහළට

28.       හනතොන ලනකස තයන ගැටල වසඳො ගනොන ොකොොහොමද? 

               ොම සදහො හනතොන ගගල සමහයට සමබනධ ව එහ ද ඔොබ පශන මත ොකොට අොප පජොොව සොමොජක  
   සොමොජකොවනොගන වසඳම ලබොගනන පළවන.         හනතොන ගගල සමහයට සමබනධ වම සදහො ොමම සබැදය 

  පොවචච කරනන http://groups.google.com/group/hanthana-community .  www.hanthana.org/irc.php මඟන 
 හනතොන IRC        නොලකොවට සමබනධ ව සජව ොලස සහොය ලබොගත හැකය. 

ඉහළට

29.              මට ඊොමල ොගොඩක එන එක කරදරය හනතොන අඩවොය අලත ොතොරතර පමණක ගනන කමයක නැදද? 

 ඔව පළවන.          හනතොන පවත සමහයට දොයක වොමන අවශ් නොවදන පමණක ලබොගත හැකය. 

https://groups.google.com/group/hanthanalinux 

ඉහළට

30.       මට හනතොන ව්ොපෘතයට සහොය වය හැක ද? 

1. පොසැොල,     කොරයොලොය මතරන දැනවත කරම

2.         හනතොන සජව තැටය නෑදෑ හතමතරන අතොර ොබදො දම

3.         දැනවත කරොම වැඩසටහන සංවධොනය සහ ඒවොට සහභොග වම

4.           හනතොන මත මෘදකොංග භොවතවන ආකරය ගැන සරල බසන සටහන සැකසම

5.     මෘදකොංග සංහල බසට පරවරතනය

6.               පජොවට අවශ් වන සහ නයමත බලපත සහතව ඔබ නපදව සදස මෘදකොංග හනතොන ව්ොපෘතයට එක 
    කරනනත ඔබට අවසථොව තොබනවො

 අනවොරයොයනම පළවන.        ඔබට පහසම කමය හනතොන ලනකස ඔොබ පොසැොල,   අධ්ොපන ආයතනොය, 
    කොරයයොලොය මතරනට හනදනවො ොදන එක,     නැහත මතරන අතොර ොබදොහරන එක.   ඔවනොග පරගනක වල 

     හනතොන ලනකස සථොපනයට සහොය වන එක.    එොමනම ඔොබ පොසැොල,     ආයතනොය ොම පළබඳ වැඩසටහන 
             සදොනම කළවට වැඩ දර දැනවත කරම හො පහණ වැඩමළ සඳහො හනතොන කණඩොයම ොගනවොගත හැකය. 

      එොස ම නදහස මෘදකොංග භොවතය පළබඳ සංහලන,        ොදමළන සහ ඉංගසොයන සරලව සටහන සැකසම සඳහො 
       දොයක වොමන ඔොබ දැනම පජොව ොවත ොදනනත පළවන. 

      වැඩදර ොතොරතර සඳහො අපොග ගගල සමහයට එකවනන.

ඉහළට

සථොපනය

1.         හනතොන සථොපනය කරගනන අවශ් අවම දෘඪොංග පහසකම ොමොනවො ද? 

             අවම වශොයන පහත දැකොවන මටටොම පවතනවො නම ඔොබ කටයත හනතොන මත වඩොත පහසොවන හො 
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    ොවගවත ව කරගනන පළවන : 

   ොපළ ආකොරය සඳහො (text-mode)  අනමත : 200 MHz Pentium Pro   ොහොෝ වැඩ

   චතක ආකොරය සඳහො (graphical)  අනමත : 400 MHz Pentium Pro   ොහොෝ වැඩ

   ොපළ ආකොරය සඳහො (text-mode)   අවම මතකය (RAM): 256 MiB 

   චතක ආකොරය සඳහො (graphical)   අවම මතකය (RAM): 640 MiB 

   චතක ආකොරය සඳහො (graphical)   අනමත මතකය (RAM): 1152 MiB 

       දෘඪ තැටොයහ තබය යත අවම හස ඉඩකඩ 15GB DVD  ධොවකයක

ඉහළට

2.    හනතොන ගනොන ොකොොහොම ද? 

   හනතොන ලබොගැනම ඉතොම පහසය. 

   ඔබ කළ යතොත http://www.hanthana.org    ොවබ අඩවයට පවස Hanthana  DVD iso    එක බොොගන DVD 
  එකකට පටපත කරගැනමය.       ඔබොග මතොරක සතව දැනටමත හනතොන ලනකස DVD   එකක තොබනම එයන 
     පටපතක ලබො ගැනමද සද කළ හැකය.      ොම සඳහො කසද නතමය බොධකයක නැහැ.    ඉහත සඳහන එක කමයකට 

       ොහොෝ පටපත ලබො ගැනමට ඔබට අපහස නම http://hanthana.org/media.php     හ සටන හනතොන ලනකස මොධ් 
     දොයකයනොගන ඔබට වඩොතම ආසනන පදගලයො අමතනන. ඔහ/     ඇය ඔබට පටපතක ලබොදමට ඔහොග/ඇයොග 

   උපරම උතසොහය දරන ඇත. 

ඉහළට

3.   හනතොන බට 64   පරගණක මත (AMD-64  ොහොෝ Intel-64)   කයොතමක කළ හැකද? 

 ඔව පළවන.       ොම සඳහො හනතොන අඩවොයන හනතොන ලනකස x86_64    සජව තැටය භොවත කරනන. 

ඉහළට

4.    හනතොන සථොපනය කරනොන ොකොොහොමද? 

  නවොස බහලම (home directory)    තළ ඇත HanthanaDocs  උප-    බහලම තළ ඇත "Installation-Guide-H15-
si.pdf"          ොගොනව වවෘත කරම මඟන අවශ් සථොපන උපොදස ලබො ගත හැක. 

ඉහළට

5.      ොකොොහොමද හනතොන ඩවල බට ොලස දොනොන  

    ොම සඳහො සථොපන සටහන බලනන.           එහ වසතර කර ඇතොත ඩවල බට ොලස හනතොන සථොපනය කරන 
ආකරයය.       ොමහද පොටෂන කරොම පයවොරද වඩොත සැලකලමත ොවනන. 

ඉහළට

6.  මොග NTFS (Windows NT/2000/XP/2003)   පොටශන බලොගනොන ොකොොහොමද? 

           සථොපන පයවර වල පොටශන කරන පයවොරද ඔබොග දැනට පවතන පොරටශන වගච දකවනවො. NTFS පොටශන 
  එම වගොව 'Type'   යටොත ntfs   ොලස ොපනවනඇත.        වැඩ වසතර සඳහො සථොපන සටහොන පොරටශන කරොම 

 ොකොටස බලනන. 

ඉහළට
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Desktop සැකසම

1. Desktop Effects /     ොඩසකොටොප රංගසැරසල සකය කරනොන ොකොොහොමද? 

 හනතොන 15      නකතොවද මන ොපර තබ Desktop Effects (  ොඩසකොටොප රංගසැරසල)    භොවත කළ ොනොහැක. 
  නමත හනතොන 15  නකතව Fail Safe Mode    ආකොරයට පවසොමන හනතොන 14   නකතොව පරද ොඩසකොටොප 

   එක භොවත කළ හැක.  එහද Desktop Effects (  ොඩසකොටොප රංගසැරසල)      ද ොපර පරදම භොවත කළ හැක. 

ඉහළට

2.   පරගණකය වසොදමනොන ොකොොහොමද? Shutdown    තොබන තැන ොහොයොගනන බෑ . 

            තරොය දකණපස ඉහළ ොකළවොර ඇත පරශලක නොමය මත කලක කර ලැොබන ොමනොවන Shut down... 
   යනන ොතරම සද කරනන. 

  එොහම නැතනම Alt+F2     එබ වට ලැොබන කවළොව halt    යනොවන ටයප ොකොට "Enter"  යතර ඔබනන. 

ඉහළට

  කොරයොලය ොයදම

1.    හනතොන එොක තොයන LiberOffice      වලන ලයමක ලයලො මම MS Office   තොයන පරගණකයකට  
 ොගනයනොන ොකොොහොමද? 

LibreOffice   වල ොලඛනයක MS Office    ොලස සරකොම පහසකම තොයනවො.    ොම සඳහො File > Save As...  හ 
File type   යටොත Microsoft Word, Microsoft Excel         ආද ඔබට අවශ් ආකොරය ොතොෝරො ඒ ආකෘතොයන ලපය 

   සරකම සද කරනන පළවන.     ොමොස සරක ලප ඔබට MS Office     තොබන පරගණයකයක තළ වවෘත කරනනත, 
  සංසකරණය කරනනත පළවන. 

ඉහළට

2.  ලයමක PDF    බවට පත කරගනන පළවනද? 

 ඔව පළවන.    ොම සඳහො File > Export as PDF...        ොමන අයතමය ොතරොමන ලැොබන කවළව භොවතො කරනන 
පළවන.       ොමහද ඔබට අවශ් පරද සටවම (Settings)   කරනන පළවන.      නමත ොබොොහොෝ වට සොමොන් PDF 

      ොගොනවක සෑදම සඳහො ොමම ොපරනම සටවම පමොණවත.   ඉනපස Export   ොබොතතම ඔබනන.  ලැොබන 
  කවළොව ඔබට PDF           ොගොනව සරකමට අවශ් සථොනය සහ ොගොන නොමයක ලබො ද Save   ොබොතතම කලක 

කරනන. 

ඉහළට

3. LiberOffice වතරද?  ඇය OpenOffice.org නැදද? 

 හනතොන 14.7     නකතොව සට අඩංග වනොන LibreOffice        වන අතර ොමය මට ොපර භොවත කළ OpenOffice.org 
       නරමොණය කළ පජොව වසන ඉදරයට ොගන යන ව්ොපෘතයක.

ඉහළට

4.   සංහොලන ලයනොන ොකොොහොමද? 

     හනතොන ලනකස පදධතොය ොපරනමොයනම සංහල (යනොකොෝඩ)   සඳහො සහොය දකවනවො.   ඔබට යතර ලයනය 
      කරම සඳහො කම ොදකක භොවත කරනන පළවන.        ඒ තමය සමමත වොජොසකර යතරපවරව සහ ොෆොනටක 
 කමය (     අකොර හඬ අනව ඇතළත කරම). 

          ඔබ දැනටමත හනතොන ොවත පවස ඇතොත සංහල අතර මහණොතන නම Ctrl + Space   එබොමන ඔබට සංහල 
    ලවොම ආකොරයට මොර වය හැකය.         ඔබ පවස ඇතොත ඉංගස අතර මහණතට නම Activities   මත කලක 

   කරොමන ලැොබන ොමනොව Other > Input Method Selector    ොතොෝරොගනන තවද Alt+F2    යතර මඟන ලබො 
   ොදන ලැොබන කවළොව im-chooser     ොලස යතර කර Enter   යතර ඔබනන.     ඉනපස ලැොබන කවළොව Use 
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IBus  (recommended)    යනන සකය කරනන.      ඉනපස එම කවළොව ඇත Input  Method  Preferences.. 
 ොබොතතම ඔබනන.   ලැොබන කවළොව Input Method   ටැබොය ඇත Select at input method  ොමනොවන Show 

all input methods        මත කලක කර ඉනපස ලැොබන දග ලැයසතොවන Sinhala;Sinhalese   යටොත ඔබට අවශ් 
  ආදොන ආකොර (Input Method)    එකක ොහොෝ කපයක (වොජොසකර,  සයර වැන) ොතොෝරනන.   ොමහද අවශ් ඇතලත 
   කරොම කමය ොතොෝරො Add  ොබොතතම ඔබනන.      ඉන පස එම කවළ ොදකම වසනන.    සංහල ලවොම ආකොරයට මොර 

          ව පස එක එක ආදොන ආකොර අතර මොර වම සඳහො (වොජොසකර,  සයර වැන) Alt + Shift   යතර භොවතො කරනන. 

ඉහළට

5.      සංහොලන ලයනන මම ොෆොනට දොගනන ඕනද? 

  හනතොන සමඟ LKLUG   සංහල (යනොකොෝඩ)       ොපරනමොයනම ලැොබන නසො අමතොවන ොෆොනට ඇතළත 
    ොනොකර සංහොලන යතර ලයනන පළවන.        ඒත අමතර ොෆොනට පරගණකයට ඇතළ කරගැනමට කසම 
 බොධොවක නැහැ. 

ඉහළට
 

6. LibreOffice    මත සංහල අකර bold   කරොම සහ "ශ"    වැන අකර ලයොවනොන "ශර"  ොලස ලයොවන  
   ගැටව වසදය හැක ද? 

             ොමය අකර සැකැසම ොතොෝරොගැනම පලබඳ ගැටළවක වන අතර සරල පයවර කහපයකන නවැරද කරගත හැක . 
LibreOffice  වවෘත කරනන.    දැන පධොන ොමනොව Tools > Options... >     ොතොෝරො ලැොබන කවලොව වමපස ඇත 
Language Setting   යටොත ඇත Languages ොතොරොගනන. 

 එහ Enhanced Language support     ොකොටස යටොත ඇත Enabled for  Asian languages   හො Enabled for 
complex text layout (CTL)    සකය කර Default languages for document    යටොත ඇත Western , Asian  හො 
CTL  පරොමත [None]  බවට හරවනන. 

ඉහළට 

 මෘදකොංග කළමනොකරණය

1.       හනතොන මත මෘදකොංගයක සථොපනය කරනොන ොකොොහොමද ? 

Activities > System (පදධතය) > Administration (කළමනොකරණය) > Add/Remove Software  යටොත අවශ් 
  “මෘදකොංගය ොතොෝරො Apply”      ොබොතතම එබොමන පහසොවනම සථොපනය කලහැකය.    ඔබට අවශ් මෘදකොංගය 

    ොවනත මෘදකොංග මත යැොපය නම,        එවට ඒවොද සථොපනය කරොම අවසරය ඔොබන ඉලලන ඇත.  ඔබට root ොග 
   මරපදය ලබො දමට සදොවනවො. 

නැතොහොත,  ටරමනලොය su -c “yum install <  මෘදකොංගොය නම>”      ොලස වධොනය ලබො දොමනත ොමම කොරයය 
  ඉට කර ගතහැකය.   ඔබට root        ොග මරපදය ලබො දමට සද වන ඇත.       ොමහද ලබො දය යත මෘදකොංගොය නම, 

Fedora                මෘදකොංග ගබඩොොව ඇත නම වය යත අතර එම නම ජනපය නොමොයන ොවනස වය හැක බව 
 කරණොොවන සලකනන. 

           ඉහත ආකොර ොදොකන ම මෘදකොංග සථොපනය කරම සඳහො අනතරජොල සමබනධතොවක තබම අවශ්ය. 

 ඔබ Fedora    සඳහො වන RPM    මොදලොය ොගොනවක ලබොගතොත නම, su -c “yum localinstall --nogpgcheck “ 
  වධොනය ොහොෝ su -c “rpm -ivh ”      වධොනය ලබොද එය සථොපනය කරගත හැකය.    ොමහ දත ඔබට root  ොග මරපදය 

   ලබො ොදනන සද ොවනවො. 

           මට අමතරව ොවනත ඕනෑම ලනකස ොමොහයම පදධතයකද ොමන අදොළ මෘදකොංගොය මලය (source) 
      ලබොොගන එය සථොපනය කරොම හැකයොව ද තොයනවො. 

ඉහළට

2.         හනතොන තළ ඇත මෘදකොංග යොවත කොල කරනොන ොකොොහොම ද? 

Activities > System Tools (  පදධත ොමවලම) > Add/Remove Software     යටොත යොවතවම සපයො ඇත මෘදකොංග 
 ොපනවන ඇත.  Update        ොබොතතම එබොමන ඔොබ පදධතය යොවත කල හැකය.    ොමහ දත root  ොග මරපදය 
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 ලබොදම අවශ්ය. 

 එොස නැතනම,    ටරමනලය මත su -c “pkcon update”   වධොනය (    හො අවශ්ය වටද root   පරශලකොග මරපදය) 
   ලබොදොමනත යොවතකොල කරනන පළවන. 

ඉහළට

3.       හනතොන තළ ඇත මෘදකොංග ඉවත කරනොන ොකොොහොමද? 

Activities > System Tools (  පදධත ොමවලම) > Software Update      යටොත අවශ් මෘදකොංගය ොතොෝරො ඉවත කර 
“Apply”       ොබොතතම එබොමන පහසොවනම ඉවත කළ හැකය.    ඔබට ොමහදත root    ොග මරපදය ලබොොදනන සද 
ොවනවො. 

නැතොහොත,   ටරමනලොය su -c “yum remove <   අවශ් මෘදකොංගොය නම>”     ොලස වධොනය ලබො දොමනද ොමම 
    කොරයය ඉට කර ගත හැක.  ඔබට root     ොග මරපදය ලබොදමට සදවන ඇත. 

ඉහළට

4.   හනතොන තළ exe     ොගොන සථොපනය කළ හැකද ?  ොකොොහොමද කරනොන? 

exe  සහ msi  ොගොන යන, Microsoft Windows        ොමොහයම පදධතය සඳහො ඇසරම කරන ලද ොගොන වරගය. ොම 
  හැම ොගොනවකම Linux            පදධතයක සමඟ භොවත කළ හැක ද යනන කලතබො තහවර කරොම හැකයොවක නෑ. 

     ඒත ොම වරගවල ොගොන ොබොොහොමයක wine      නම මෘදකොංගය උපකොරොයන සථොපනය කරනන පළවන. 

Activities > Other (ොවනත)  යටොත wine      සමඟ සථොපනය කළ ොයදම දකනට ලැොබ.

      දැන සථොපනය කරගැනමට අවැස මෘදකොංගය සහත exe  ොහොෝ msi     ොගොනව රයට කලක කර "Open with Wine 
Windows Program Loader"  යනන ොතොෝරනන.  දැන Microsoft Windows    මත සථොපනය සදොවන ආකොරයටම 

   සථොපනය සොමොන් ොලස සදොවව. 

     සථොපනය ොනොකර ධොවනය කර හැක exe  ොගොනද (උදො:- flash projector ොගොන)    රයට කලක කර "Open with 
Wine Windows Program Loader"     යනන ොතොෝරොගැනොමන ධොවනය කළ හැකය. 

Wine        මගන සථොපනය කරන ලද මෘදකොංග ොවත පවසම Activities > Other (ොවනත)    කොණඩය යටොත ලබො 
 ගත හැක.Wine        සමඟ සථොපනය කළ මෘදකොංග ඉවත කරමට Activities > Other > Wine Software Uninstaller..  

 ොතොෝරනන Add/Remove  Programs         ොවත පවස ඉවත කරමට අවැස මෘදකොංගය ොතොෝරො Remove  කලක 
කරනන. 

Wine    හ සැකසම ොවනසකරම Activities > Other > Wine Configuration    මගන සද කළ හැකය. 

ඉහළට

 ජොල සැකසම

1.  පරගණකොය IP      ලපනය සහ අොනකත ොතොරතර ොදනොන ොකොොහොමද? 

       පරගණක ජොලයකට සමබනධ ොවනනට නම ඔොබ පරගණකයට IP       ලපනයක සහ තවත ඒ හො සමබනධ 
   සැකසම කහපයක තොබනනට අවශ්ය.       එොස සැකොසනනට පධොන කම ොදකක ඇත.     එක කමයකද ඔබ ඒ 
             සැකසම සඳහො අගයන ලබො දය යත අතර අොනක කමොයද අදොළ සැකසම පරගණක ජොලොයනම ලබොගැනොම  
 හැකයොව (DHCP භොවතොයන) තොබනවො. 

       ජොලයන සවයංකය ොලස සැකසම ලබො ගැනම සඳහො DHCP (Dynamic Host Configuration Protocol)  භොවත 
 වන අතර,       ඒ සඳහො ඔබ සමබනධවන ජොලොය DHCP      ොසවොව ලබොොදන ොසවොදොයකොයක තබය යතය. 

        වොශෂොයනම ඔොබ ජොලය රහැන රහත එකකනම ොබොොහොෝදරට එහ DHCP   ොසවොව තබය හැකය.  එොස නැත 
   නම ඔබට සදස IP      ලපනයක පරගණකය සඳහො ොතොෝරොගැනමට සදොව.      ොම සඳහො ඔොබ අනතරජොල ොසවො 

   සපයනනො ොහොෝ පරගණක පදධත/      ජොල පරපොලකොග උපොදස පැතම වඩො ොයොෝග්ය. 

DHCP              ොසවොව ඇත ජොලයක ඒ ොසවොව භොවතොයන ජොලයට සමබනධ වම සඳහො ඔොබ පරගණකයට අදොළ 
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  ජොල රහැන (ඇතනම)         සවකරොමන අනතරව තරොය ඉහළ ඇත පධොන පැනලොයන NetworkManager 
      අයකනය කලකකර රහැන සහත ජොලයක සඳහොනම Wired ටැබයද,     රහැන රහත ජොලයක සඳහොනම Wireless 

 ටැබයද ොතොෝරනන.          එහද අදොල ජොල සබඳතොව සකය කර ගැනමට අවකොශ ලැොබ . 

             පධොන පැනලොය දකණ පස ඇත පරශලක නොමය මත කලක කරම මඟන ලැොබන ොමනොවන System 
Settings ොතොෝරනන.  දැන Hardware   යටොත ඇත Network     ොතර වට සමබනධතොවොය ොතොරතර ොපනවනය. 

      උදොහරණයක ොලස රහැන සහත ජොලයක හරහො DHCP       මඟන සමබනධව ඇත නම කසද සැකසමක 
 ොනොකරම Hardware Address, Speed, IP Address, Subnet Mask, Default Route,  සහ DNS  යන ොතොරතර 

ොපනවය. 

        නමත ඔොබ පරගණකයට අදොල සැකසම ලබො දම සඳහො Wired, Wireless  සහ Network Proxy   යන කොණඩ 3න 
Wired         කොණඩය ොතොරො එහ ඇත ඇත සවචය එබම මඟන ON  තතතවයට පතකරනන.    දැන පහත ඇත Option 

     ොබොතතම එබ වට ලැොබන කවලොවන Wired, 802.1x Security, IPv4 Settings  සහ IPv6 Settings   යන ටැබ 4 
 දසොවන ඇත.   එයන IPv4  Settings   ටැබය ොතොෝරනන.   දැන Method      යටොත ඇත පහළට දග හැොරන 

 ොමනොවන Automatic (DHCP)  ොහොෝ Manual   යනන ොතොෝරොගත හැක. 

   ඔොබ පරගණයට සවයංකයව IP       ලපන ොතොරතර ලබො දම සඳහො DHCP     ොසවොව ලැොබ නම Automatic 
(DHCP)    ද එොස සවයංකයව IP     ලපන ොතොරතර ොනොලැොබ නම Manual  යනනද ොතොෝරොගනන. 

 සවයංකයව IP     ලපන දම සඳහො Method   යටොත Automatic  (DHCP)   යනන ොතොෝරොගනන.  පරගණකය 
        පනගනවන හැම වටම එම ජොල සබඳතොව භොවතො කරමට වවමනොනම,     සබඳතොොව නම සපයන තැනට පහලන 

 ඇත Connect automatically   සඳහො සලකණ කරනනන. අවසොනොයද, Save     ොබොතතම ඔබො ොම කල සැකසම 
 තහවර කරනන.     ොබොොහොෝ වට ොමතැනදද ඔොබන root     ොග මරපදය ලබොදමට සදවන ඇත. 

 ොමොස DHCP      ොසවොව ලබො ද නැත වොටක,        අදොල ොතොරතර ඔබ වසන ඇතල කල යතය.    ොම අගයන ලබො 
   ගැනමට ඔබ ඔොබ ජොල/     පදධත කළමණොකර ොහොෝ පරපොලකොගන වමසනන.  දැන Method  යටොත Manual යන 

  අගය ොතොරො ගනන.    ඉන පස Addresses    ොකොටසට අදොලව ඇත Add  ොබොතතම ඔබනන.  පසව, IP Address, 
Netmask   සහ Gateway         යන සැකසම සඳහො අවශ්ය කරන අගයන ලබො ොදනන.  උදො:  IP  Address: 
192.168.110, Netmask: 255.255.255.0   සහ Gateway: 192.168.1.1.   මන පස,  DNS Server   සඳහො ඔබොග 

 ජොලොය DNS    ොසවො සපයනනොොග IP    ලපනය ලබො ොදනන.       පරගණකය පනගනවන හැම වටම එම ජොල 
   සබඳතොව භොවතො කරමට වවමනොනම,        සබඳතොොව නම සපයන තැනට පහලන ඇත Connect automatically 

  සඳහො සලකණ කරනන. අවසොනොයද, Save       ොබොතතම ඔබො ොම කල සැකසම තහවර කරනන.  ොබොොහොෝ වට 
  ොමතැනදද ඔොබන root     ොග මරපදය ලබොදමට සදවන ඇත. 

      ොම ආකොරොයන ජොල සබඳතොවය සකසොගත පස Network    සැකසම වසො දමනන.     දැන ඔබ ජොලයට සමබනධ 
 වමට සදොනම. 

ඉහළට

2.  මොග Dongle     එොකන අනතරජොලයට යනොන ොකොොහොම ද? 

    ොඩොංගල එක පරගණකයට සමබනධ කරනන.   ටක ොවලොවකන Network Manager    වසන ොඩොංගල එක හදනො 
   ගනනො අතර එවට Neteork Manager        අයකනය මත කලක කලවට ලැොබන ොමනොවන Auto broadband 

 ොලස ොතොෝරනන.     එවට ඔොබ ොඩොංගලොය නෂපොදක(Manufacturer)   හො ොමොඩලය(Model)   සඳහන කවළවක 
ලැොබව.     එයන ඔබ සොදන Mobile  BroadBand  Connection       එක සඳහො භොවතො කරනොන ොම ොඩොංගලය 

           පමණකද නැතනම ොවනත ොඩොංගලයක භොවතො කරලත ොමම සමබනධතොවය භොවතයට ඉඩ ොදනවද යනන 
  ොතොෝරො ඉදරයට යනන.      මළඟ කවළොවන අදොල රට ොලස Sri Lanka ොතොෝරනන.     දැන ශ ලංකොොව සයළම ජංගම 

            දරකථන සමොගම වල ලැයසතවක දකවො ඇත අතර එයන ඔබොග අනතරජොල ොසවො සමපොදක (Internet 
Service  Provider)    ොතොෝරො ඉදරයට යනන.         මළඟ කවළොවන ඔබ භොවතො කරන පැොකජය ඇතනම එය 
ොතොෝරනන.    එොස ොනොමැතනම My plan is not listed    වකලපය ොතොෝරො APN (Access Point Name)  නොමය 

   සඳහන කර ඉදරයට යනන.         ඔබට ොමම සමබනධතොවය ොඩොංගලය පරගණකයට සමබනධ කරනවොත සමගම 
 සවයංකයව (Automatically)       අනතරජොලය සමඟ සමබනධ වමට අවශ්නම Connect  Automatically  යනන 

ොතොෝරනන. 

         දැන ඔබොග පරගණකය ොඩොංගලය මගන අනතරජොලය ොවත සමබනධ වමට සදොනම.    දැන ඔබ Connect 
Automatically     යනන ොතොෝරො ොනොමැතනම Network Manager      ොයදම කලක කර අදොල Mobile BroadBand 
Connection    එක ොතොරො කලක කරනන.        දැන ඔොබ පරගණකය අනතරජොලය හො සමබනධ ව ඇත. 

           සමහර අවසථොවලද ොඩොංගලයය මගන අනතරජොලය ොවත සමබනධ වවත ොවබ අඩව ොවත පවසමට 
 ොනොහැක ොව.  ොමවට DNS ොසවොදොයක(Servers)    හඳනොොගන ඇතදැය පරකෂොකර බලනන. 
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        ොඩොංගලය ආරකෂතව පරගනකොයන ගලවො ඉවත කරගැනම සඳහො මලනම Network  Manager  ොයදොම 
   අයකනය කලක කර Disconnect       යනන කලක කරොමන සමබනධතොවය වසනධ කරනන.   දැන ොඩොංගලයට 
 සමබනධ තැට(Disks)       ඇතනම ඒවො රයට කලක කර Safety Remove Disk     මගන ඉවත කරනන කරනන. 

(     සවයං සථොපන වැඩසටහන සහත තැටය[Self Installer Disk],   මතක කොඩ පත[Memory Chip] ආදය)  දැන ඔොබ 
     ොඩොංගලය ආරකෂතව ගලවො ඉවත කරගත හැක. 

ඉහළට 

3.    හනතොන ලනකස සථොපනය කළො ,    නමත අනතරජොලයට පවොසනන බැ  

      මට ොහතව වය හැකොක ඔොබ පරගණකය Proxy  ොසවොදොයකයක(Proxy  Server)   හරහො අනතරජොල 
    සබඳතොවය ලබොොගන තබම වය හැක.      ඒ සඳහො ඔබොග පරගණක පදධත/    ජොල පොළකොගන අදොල Proxy 

 ොසවොදොයකොය IP   ලපනය හො ොපොරට(port) ලබොගනන. 

        දැන පරශලක නොමය මත කලක කර ලැොබන ොමනොවන System  Settings    මත කලක කරනන.  දැන 
Hardware   යටොත ඇත Network ොතොෝරනන.  දැන Network Proxy   ොවත පවස Manual   යනන ොතොෝරො පරගණක 
පදධත/    ජොල පොළකොගන ලබොගත Proxy   ොසවොදොයකොය IP  ලපනය/   ලපනයන හො ොපොරට(port)  ලබොද 
කවළොවන(Window) ඉවතවනන.        දැන ඔොබ පරගණකය සොරථකව අනතරජොලය හො සමබනධව ඇත. 

උදො:-      ඔබ අනතරජොලය හො සමබනධ වනොන Schoolnet      ජොලය මගන ලබොද ඇත සබදතොවයකනනම ොපොකස 
 ොසවොදොයකොය (Proxy Server) IP    ලපනය ොලස 10.250.20.20     ත ොපොරට එක (port) 3128   ොලසත ලබොදය 

යතය. 

ඉහළට

4.    මොග අනතරජොල ොසවොදොයකයොොග (ISP) DNS  දැනගනොන ොකොොහොමද? 

      සමහර අවසථොවලද අනතරජොලය හො සමබනධ වොමද DNS  (Domain  Name  Server)   ොසවොදොයක සමඟ 
    සවයංකයව හඳනො ොනොගනනො අවසථො ඇත.         ඔබට අනතරජොලය හො සමබනධ වවත ොවබ අඩව ොවත පවසමට 

  ොනොහැකනම ඊට DNS       ොසවොදොයක හඳනො ොනොගැනම ොහතවක වය හැක.  DNS   ොසවොදොයක හඳනොොගන 
    ඇතද යනන පරකෂො කරමට Network  Manager      ොයදම රයට කලක කර Connection  Information  ොවත 

පවොසනන.  එහ Primary DNS, Secondary DNS  යනොවන IP     ලපන ොදකක ොනොමැතනම ඉන කයොවනොන 
    ඔොබ අනතරජොල සබඳතොවයට අදොල DNS  ොසවොදොයක Network Manager    වසන හඳනොොගන ොනොමැත බවය. 

     සොරථක අනතරජොල සබඳතොවකට අවම අශොයන Primary DNS    අගය වත තබම වැදගත. 

DNS         ොසවොදොයක සැකසම ඔබම සකස කරගැනොමන ොම ගැටළව වසඳොගත හැක.    පධොන පැනලොය දකණ පස 
         ඇත පරශලක නොමය මත කලක කරම මඟන ලැොබන ොමනොවන System  Settings  ොතොෝරනන.  දැන 

Hardware    යටොත ඇත Network       යනන ොතොෝරො ඉනපස ලැොබන කවලොවන Wired     මත කලන කර ජොලයට 
     අදොල සැකසම ොවනස කරම සඳහො Options..   මත කලක කරනන.     ඉනපස ලැොබන ටැබ අතරන IPv4 Settings 

  යටොත ඇත DNS  servers    ොතොරතර ලබො ොදනන.  DNS    කහපයක ොදදද ,  (ොකොමොව)   මඟන එකොනක 
  ොවනකර දක වනන. 

1.  රහැනරහත(Wireless)   ොහොෝ රහැනරහත(Wired)   සබඳතොවයකනම Method  ->  Automatic  (DHCP) 
addresses only  ොලසත

2.     ොඩොංගලයක භොවතො කර Mobile BroadBand   සබඳතොවයකනම Method -> Automatic (PPP) addresses 
only  ොලසත

3. DSL  සබඳතොවයකනම Method -> Automatic (PPPoE) addresses only  ොලසත

ොතොෝරනන.   දැන DNS Servers   හ පොථමක(Primary) DNS  ොසවොදොයකොය IP     එක සටහන කර ොකොමොවකන 
   ොවන කරොමන පස දවතක(Secondry) DNS  ොසවොදොයකොය IP   එක සටහන කරනන. 

ඉහළට

 පරශලක කළමනොකරණය

1.   මොග මරපදය (password)    ොවනස කරගනොන ොකොොහොම ද? 
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        ඉහළ පැනලොය ඇත පරශලක නොමය මත කලක කර My Account ොතොෝරනන.   ඉනපස ලැොබන User Accounts 
   කවලොව ඔොබ පරශලක නොමය,     භොෂොව සහ මරපදය දකවය.        මරපදය මත ොදවරක කලක කළ වට ලැොබන 
        කවලොව දැනට ඇත මරපදය සහ නව මරපදය ඇතළත කරනන.        ඔබ ලබො ොදන මරපදය සඳහො වන ඉඟය 
   පදධතයට පවසම තරොය (login screen)         ොපනවන බැවන පදධතොය සයල පරශලකයනට එම ඉඟය ඔනවන 

  බව කරණොොවන සලකනන.       එම ඉඟය සඳහො මරපදය එක ොනොකරනන.       සැකසම ලබො ද අවසන ව පස 
Change  ොබොතතම ඔබනන.

   එොස නැතනම ටරමනලොය root   ොලස passwd <  පරශලක නොමය>    වධොනය ලබො ොදනන.   දැනට පවතන 
   මරපදය ලබො ද enter ඔබනන.     අලත මරපදය ලබො ද enter ඔබනන.      නැවත අලත මරපදය ලබො ද enter ඔබනන. 

ඉහළට

2.       හනතොන මත අලතත ගණමක හදනොන ොකොොහොමද ? 

Activities > Other > Users and Groups  ොවත පවොසනන.   ොමහද ඔබට root     මරපදය ලබොදමට සද වන ඇත. 
  ‘ලැොබන කවළොව Add User’    ොබොතතම කලක කරනන.     ලැොබන කවළොව පරශලක නොමය,  පරශලකොග 
 සමපරණ නම,       “මරපදය සහ මරපදය නැවත ටයප කර OK”   ොබොතතම කලක කරනන.

ඉහළට

3.       හනතොන තළ ඇත ගණමක මකනොන ොකොොහොම ද? 

Activities > Other > Users and Groups  ොවත පවොසනන.   ොමහද ඔබට root     මරපදය ලබොදමට සද වන ඇත. 
       ‘ඔබට මැකමට අවශ් ගණොම පරශලක නම ොතොෝරො Delete’   ොබොතතම කලක කරනන.   ොමහද එම පරශලකට 
   අයත නවොස බහලම (Home Directory),          ලප අඩංග බහලම සහ තොවකොලක ොගොන මැකමට සටහන කරන ලද 

  පණවඩයක දස ොවනවො.       ඔබට ොමවො මැකමට අවශ් නම 'Yes'    ොබොතතම කලක කරනන.    ඔබට ඒවො තබො 
         ගැනමට අවශ් නම එම පණවඩොය හර ලකණ ඉවත කර 'Yes'   ොබොතතම කලක කරනන. 

   එොස නැතනම ටරමනලොය 'userdel <  පරශලක නොමය>'        ොලස වධොනය ලබො දොමන පරශලක මැකය හැක. 
'userdel  -r  <  පරශලක නොමය>'           ොලස වධොනය ලබො දොමන ොපර සඳහන කල පරශලකට අයත නවොස 
ොෆොෝලඩරය,     තොවකොලක ොගොන ආදය මැකය හැකය. 

ඉහළට

4.       හනතොන තළ ඇත ගණමක ොවනස කරනොන ොකොොහොමද? 

Activities > Other > Users and Groups  ොවත පවොසනන.   ොමහද ඔබට root     මරපදය ලබොදමට සද වන ඇත. 
        ‘එහ ඔබට ොවනස කරමට අවශ් පරශලක නොමය ොතොෝරො Properties’   ොබොතතම කලක කරනන.  එහද පරශලක 

නොමය,   සමපරණ නම,           මරපදය වැන ොතොරතරද මරපදය කල ඉකත වය යතද එොසනම කවදද,  කමන 
  අවසථොවලද ආද සටවම(settings)    ොවනස කරමට හැක.        අවශ් ොවනස කරම සද කළ පසව OK  ොබොතතම 

 කලක කරනන. 

ඉහළට

 ආරකක සැකසම

1.   ොමොකකද ොම SELinux? 

SELinux (Security-Enhanced Linux) යන, Linux      ොමොහයම පදධත සඳහො සැකස ආරකණ වධකමයක. ොමහද 
              පදධතොය කයොතමක වන කයොවලන සඳහො අවශ් අවසර සමො කරන අතර ොම සමො කරම ආරකෂොව පළබඳ 

    අවදොනම වශොල වශොයන අඩ කරනවො. 

ඉහළට

2. SELinux      නසො මොග එදොනදො කටයතවලට කමක ොවයද? 

   සොමොන් භොවතය සඳහො SELinux      සකය වම ගැටලවක ොවනොන නෑ.      ඒත සමහර අවසථොවල ගැටල ඇත 
  ොවනන ඉඩ තොයනවො.   උදොහරණයක ොලස,     අමතර දෘඪ තැටයක (Hard  Disk)   සවකරන වට,  ලනකස 

   ොමොහයම පදධත ොදකක SELinux    භොවත කරමන /home     ොපොදොව භොවත කරන වට,   සමහර මෘදකොංග 

2011  ොනොවැමබර 10 -         හනතොන ලනකස පොලඛන කණඩොයම  14

www.hanthana.org
info@hanthana.org   හනතොන ලනකස සථොපන උපොදස

http://www.hanthana.org/
mailto:info@hanthana.org


  සථොපනයට හො භොවතයට. 

ඉහළට

3. SELinux සකය /    අකය කරනොන ොකොොහොමද ? 

  පධොන ොමනොවන Activities > Other > SELinux Management   ොවතට පවොසනන

 ොමහද Status  යටොත System Default Enforcing Mode  යනන Enforcing  ොහොෝ Permissive   ොලසට ඇතනම 
 එය Disabled   ොලසට ොවනස කරනන. 

ඉහළට

  ජංගම දරකථන සැකසම

1.   මොග ජංගම දරකථනොය /   ොඩොංගලොය ඇත SMS  සහ Contacts     මට හනතොන මතද බලොගත හැකද? 

   ොම සඳහො ඔබට Wammu    ොයදම උපකොර ොවනවො.        මලනම ඔබ ඔොබ ජංගම දරකතනය ොහොෝ ොඩොංගලය 
   පරගණකයට සමබනධ කර Activities  >  Applications  >  Accessories  >  Wammu   මගන Wammu  ොවත 

පවොසනන.           ොබොොහොෝ අවසථොවලද ඔබ ජංගම දරකතනයට ොහොෝ ොඩොංගලයට අදොල සැකසම Wammu  මත 
      සකසකර ොනොමැතනම සැකසම සකස කරම අවශ්දැය Wammu      ඔොබන වමසන අතර එොස ොනොමැතනම 

Wammu -> Phone wizard   ොවත පවොසනන.    මළඟට දසවන කවළොවන(Window) Next    කලක කර ඉදරයට 
යනන.   ොමහද සැකසම වකලප(Options)        තනක ලබොද ඇත අතර එයන වඩො පහස Automatically search for a 
phone     යනන කලක කර ඉදරයට යනන.        මළඟට ඔබ ජංගම දරකතනය ොහොෝ ොඩොංගලය පරගණකයට සමබනධ 

      කර ඇත ආකොරය ොතොෝරොොගන ඉදරයට යො යතය.  (උදො:-      ජංගම දරකතනයකනම පරගණකය හො සමබනධ 
  කරගන ලබනොන Bluetooth  හරහොද,  USB    ොකබලයක මගනද යනන)      ොමහ දකනට ලැොබන ොවබ අඩව 
 සබැඳය (Web  URL)         ොවත පවසොමන ඔබොග ජංගම දරකථනයට ොහොෝ ොඩොංගලයට Wammu  සහොයොෝගය 

    දකවනොනද යනන පරකෂො කළ හැකය.         ඉන පස ලැොබන කවළොවන ජංගම දරකථනය ොහොෝ ොඩොංගලය 
Wammu      වසන හඳනොගනනොතර මදක ඉවසො රඳ සටනන.  අනතරව Configuration done  යනොවන කවළවක 

    ලැොබන අතර ඉන කයැොවනොන Wammu        ඔොබ ජංගම දරකතනය ොහොෝ ොඩොංගලය සමඟ සමබනධවමට 
 සදොනම බවය.  දැන Finish    කලක කර සැකසම සරකනන. 

ොපරනමයක(default)  ොලස Wammu       ආරමොයදම ජංගම දරකතනය ොහොෝ ොඩොංගලය සමඟ සමබනධ(Connect) 
    වනොන නැත අතර ඔබට Wammu        ආරමභොයදම ජංගම දරකතනය ොහොෝ ොඩොංගලය සමඟ සමබනධවමට 

 අවැසනම Wammu -> Settings -> Automatically connect to phone at startup    වකලපය ොතොෝරොගත යතය. 
  එොස ොනොමැතනම Phone -> Connect    මගන සමබනධ වය යතය.  මළඟට One moment please. connecting 

to phone....            යනොවන පණවඩයක ලැොබන අතර එය සැඟව යොොමන කයැොවනොන ඔොබ ජංගම දරකතනය 
   ොහොෝ ොඩොංගලය සමඟ Wammu    සමබනධ ව ඇත බවය.  දැන Retrieve -> Info    මගන ඔබට ජංගම දරකතනොය 
  ොහොෝ ොඩොංගලොය නෂපොදක(Manufacturer),  වරගය(Model),   සමපොත දතත(Message  Center  etc.),  IMEI 
   අංකය ආදය ලබොගත හැක.           සමහර අවසථොවලද ොඩොංගලයක අනතරජොලය හො සමබනධ ව ඇත වට Wammu 
   මගන ඒ සමඟ Contact       වය ොනොහැක අතර එවට අනතරජොල සමබනධතොව Network Manager  ොයදම මගන 

Disconnct      ොතොෝරො වසනධ කරොමන පස නැවත Wammu      මගන සමබනධ වමට උතසොහ කර බලනන. 

         ජංගම දරකතනයක ොහොෝ ොඩොංගලයක සමඟ සමබනධ වවත එහ ඇත Contacts,  SMS   ආදය Wammu 
  ොනොකයවන බැවන Retrieve -> Contacts (All)   මගන දරකතන මතකොය(Phone memory)   මත හො සම(SIM) 

    පොත ද ඇත සයළම Contacts wammu  ොවත ආයොත(Import) කරගන.     ොමතැනද ඔබට අවැස වනොන දරකතන 
  මතකොය ඇත Contacts   පමණකනම Retrieve  ->  Contacts  (Phone)  යනොවනද,    සම පොත Retrieve  -> 

Contacts   පමණකනම Contacts (SIM)    යනොවනද ොතොෝරොගත යතය.  Contacts  කයැවම,  සංසකරණය(Edit), 
මැකම(Delete)        ආදය ොමහද ඔබට කළ හැක අතර අලතන Contacts   එකතකරගැනම සඳහො Create -> Contact 
අනගමනය(Follow) කරනන. 

 ඔබට SMS     කයවම සඳහො ද Retrieve  ->  Messages   මගන SMS  ආයොත(Import)   කරගත හැකය.  දැන 
කවළොව(Window)    වමපසන ඇත තරොව Messages  තල Read, Sent, Read, Unsent  ොලස SMS  වරග කර 
ඇත.  SMS  කයැවම,  මැකම(Delete)     ආදය ොමහද කළ හැකය.  SMS    යැවම සඳහො Create  ->  Message 
ොතොෝරොගනන.   දැන SMS   පණවඩය ලබනනො(Recipient) Recipient       හ දරකතන අංකය ලබොදොමන ොහොෝ Add 

  කලක කර Contacts   ොවතන ොතොෝරොගත හැක.  දැන OK    යනන කලක කරොමන SMS   පණවඩය යැවය හැකය. 

Wammu    මගන ලැොබන SMS         එොවොලම කයවමට හැකයොවක ොනොමැත අතර ඒ සඳහො Gnome Phone 
Manager   භොවතො කළ හැකය.    ඒ සඳහො Activities > Applications > System Tools > Phone Manager මගන 
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 පවොසනන පළවන.  Network Manager        අයකනය අසල ඇත ජංගම දරකතනයක අයකනය Gnome Phone 
Manager   හ අයකනයය.           එය රත පැහැොයන යත පසබමක දසවනොනනම ඉන කයැොවනොන ඔොබ ජංගම 

       දරකතනය ොහොෝ ොඩොංගලය සමඟ සමබනධ ව ොනොමැත බවය.  එවට Gnome Phone Manager  සැකසම සෑදය 
යතය.    ඒ සඳහො Gnome Phone Manager       අයකනය මත රයට කලක කර Preferences   ොතොෝරො Connection 

       ටැබය මතද ජංගම දරකතනය ොහොෝ ොඩොංගලය ොතොරො ගනන.     ඒ සඳහො ජංගම දරකතනයක Bluetooth  භොවත කර 
     සමබනධ වනොන නම කළ යතොත Bluetooth  වකලපය(Option)   ොතොෝරො Click  to  Select  device  මගන 

ොතොෝරොගැනමය.       එොසත ොනොමැත නම තොබන පහසම වකලපය Other port  ොතොෝරො Wammu  වවෘත කරොගන 
Wammu -> Settings -> Connection -> Device     මත ඇත අගය පටපත(Copy)   කර ඇලවමය(Paste).  ජංගම 

      දරකතනය ොහොෝ ොඩොංගලය සමඟ ඇත සමබනධතොව වසනධ(Disconnect)     වන අවසථොවල ද නැවත 
ඉොබ(Automatically)     සමබනධ වම සඳහො Automatically retry connections  වකලපය(Option)  ොතොෝරොගැනම 
වැදගත.  Gnome  Phone  Manager   ොවතන SMS       පණවඩයක ලැොබන අවසථොවලද එය දසවන ආකොරය 
Interface      ටැබය ොවත පවසොමන සකසොගත හැකය.  Pop-up  window  for  new  messages  යනන 

   ොතොරොගැනොමන ලැොබන සෑම SMS    පණවඩයකම නව කවළවක(new Window)     වවෘත වන අතරම Play 
sound when messages arrive     යනන ොතොෝරො ගැනොමන SMS     පණවඩයක ලැොබන අවසථොවලද ශබදයක 

 වොදනය ොවනවො. 

Gnome Phone Manager  ොවත SMS          අලතන ලැබ ඇතනම එය සද ලයම කවරයක පසබමක ඇත අයකනයක 
  මගන සංොතකවත කරනවො.   එවට Gnome Phone Manager     අයකනය කලක කරොමන SMS   කයවය හැක 

  අතර එම කවළොවම(Window)  ඇත Reply     ොබොතතම කලක කරොමන පළතර SMS  යවනන පළවන.  අලතන 
SMS   යැවම සඳහො Gnome Phone Manager     අයකනය රයට කලක කර Send Message   මගන පණවඩය හො 
ලබනනො(Recipient)   සඳහන කර Send   කලක කළ යතය. 

  පරගණකය ආරමභොයදම Gnome Phone Manager      ද ආරමභ වය යත නම System (පදධතය) -> Preferences 
(අභොපත) -> Startup Application    වවෘත කර Add     කලක ලැොබන කවළොව Command  යනොනහ "gnome-
phone-manager"    යනොවන සඳහන කර Add   යනන කලක කරනන. 

ඉහළට

 ොවනත

1.   හනතොන ලනකසහ touch pad tapping   වැඩ කරනොන නෑ .    ඒක හදො ගනොන ොකොොහොමද? 

 හනතොන 14  හ Touchpad Click  සහ Edge Scrolling   කයොතමක කර ගැනම. 

       පළමව ඉහළ පැනලොය පරශලක නොමය මත කලක කර,  System  Settings  ොතොෝරනන.   දැන ොලොබන 
 කවලොවන Hardware    යටොත ඇත Mouse  and  Touchpad  ොතොෝරනන.   එහ Touchpad   ටැබයට ොගොස, 

Touchpad Click    කයොතමක කර ගැනමට Enable mouse click with touchpad    යනන ඉදරොයන හර සලකණ 
 දමො ගනන. 

Edge  Scrolling     කයොතමක කර ගැනමට Scrolling     යටොත ඇත වකලපවලන Edge  Scrolling  යනන 
ොතොෝරොගනන.    ඔබොග පරගණකොය Touchpad   එක Two-finger scrolling      සදහො සහොය දකවනවො නම අදොළ 

      වකලපය ොතරම මඟන එය කයොතමක කරගත හැකය.     තවද තරස අතට Scroll     කරමට අවශ් නම Enable 
horizontal scrolling          යනන ඉදරොය හර සලකණ දමො ගනොමන එයද කයොතමක කරගනන පළවන. 

ඉහළට

2.       මොග හොඩ ඩසක එොක ඉඩ බලොගනොන ොකොොහොමද? 

Activities  > System Tools  > System Monitor  හ File  Systems       ටැබොය ඔබොග දැනට ඇත පොටශන වල 
ධොරතොව,   හස ඉඩ,      ොගොන වරගය ආද ොතොරතර ොපනවය.      ‘මට අමතරව ඔබට ටරමනලොය df -h’  වධොනය 

  භොවත කරමටත පළවන. 

 ොමහද System Monitor  ොදකක Gnome  සහ KDE         ව්ැපෘත ොදොකනම ලබො ද ඇත අතර අයක ොදොකන පළමව 
    ඇත අයකනය මත කලක කරනන. 
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ඉහළට

3.  අනතරජොල ොවගය , CPU, Memory   භොවතය බලොගනොන ොකොොහොමද?

Activities  >  System  Tools  >  System  Monitor   ොවත පවොසනන.   එහ Resources    ටැබොය ඔබට ොමම 
   ොතොරතර බලො ගත හැකය. 

 ොමහද System Monitor  ොදකක Gnome  සහ KDE         ව්ැපෘත ොදොකනම ලබො ද ඇත අතර අයක ොදොකන පළමව 
    ඇත අයකනය මත කලක කරනන. 

ඉහළට

4.       ඩසක එොක තොයන ෆයල එකක ොහොයොගනොන ොකොොහොමද? 

Activities   මත කලක කරනන.     එවට දකණ පපස ඉහළන Type to search...     ොලස ොසවම ොපොදසක ලැොබන 
      අතර එය තළ ඔබට ොසවමට අවශ් බහලොම,     ොගොනොව ොහොෝ ොයදොම නම ොදනන.

   දකණ පස ඇත File Browser (Nautilus)       වවෘත කර එහ පධොන ොමනොව Go   යටොත ඇත Search for Files.. 
  මත කලක කරනන. 

 ‘ටරමනලොය locate’        ‘වධොනය භොවතො කරමන නමන ොගොනවක ොසවමද find’    වධොනය භොවතො කරමන 
 ොගොනොව පමොණය,           ොගොනොව අයතකර ආද ොබොොහොෝ පරොමතනට අනව ොසවම සද කරමටත පළවන. locate 

   වධොනය භොවතයට ොපර updatedb      වධොනය භොවත කර ඇතනම locate     වධොනොය පළතර වඩො නවැරද 
   පළතරක ොලස ලබො ගතහැකය.           එොස ොනොමැත නම ොමොොහොතකට ොපර මකන ලද ොගොන ආදය locate 

  වධොනොයන ොපනවන ඇත. 

ඉහළට

5.       ලනකසහ වධොනයක පළබඳ වැඩ වසතර ොසොයොගනොන ොකොසද? 

 ටරමනලොය 'man <      ොතොරතර බලො ගැනමට අවශ් වධොනොය නම>'      ොලස වධොනය ලබො දොමන එම වධොනය 
 පළබඳ වසතරයක,    එහ භොවතොය උදොහරණ,          ඊට අනරප ොවනත වධොන ආද ොතොරතර රොශයක ලබො ගත 

හැකය. 

උදො: ls          වදොනොයන ොකොරනොන යම පහටමක ඇත ොගොන හො බහලම ලැයසතව ොපනවම. 

man ls  මඟන ls      වධොනය පළබඳ ොබොොහොෝ ොතොරතර ලබොගනන පළවන. 

ඉහළට

6.      හනතොන සංහල අතර මහණතට පවොසනොන ොකොොහොමද? 

             හනතොන පවසම තරොය පරශලක නම කලක කර වමපස පහළ ොකළවොර භොෂොව ොතරොම ොමනොවන (දැනට 
English (United States)   ොලස ොපනවො ඇත) Other... ොතොෝරනන.     ලැොබන භොෂො අඩංග ලැයසතොවන Sinhala 
(Sri  Lanka)   ොතොෝරො OK    ොබොතතම කලක කරනන.         දැන ඔබොග මරපදය ලබො ද හනතොන වැඩතලය ොවත 
පවොසනන.

ඉහළට

7. terminal   යන කමක ද? 

            ලනකස ොමොහයම පදධතය බොවතො කරොමද අප දැනගත යත ඉතො වැදගත කරනක වනොය "ලනකස 
ටරමනල"     එක භොවත කරන ආකොරයය.        ලනකස ටරමනලය යන ලනකස ොමොහයම පදධතොය පරඝණකය 

      ොවත වධොන ලබොදම සදහො ොයොදොගන ලබන කමයක.     ොෆොඩොෝරො ොමොහයම පදධතය සමපරණොයනම ගැෆකල 
             පදධතයක උවද ඔබොග අභරචය පරද පරඝණකය ොවත වධොන ලබොදම සදහො ඔබට ටරමනල එකද භොවතොකල 

හැකය.                ඔබට ගැෆකල පදධතය භොවත කර සදකරන ලබන සයලම වධොන ලබොදම ටරමනල එක මගන ද සද 
 කළ හැකය.               ොමය ඔබට පළමව භොවතො කරොමද අපහස ොලස දැනනත ඔබ ොමයට හරව පස ඔබ ගැෆකල 

     වධොන ොවනවට ටරමනලය බොවතො කරන ොනොඅනමොනය. 

             ඔබට ොෆොඩොෝරො ොමොහයම පදධතය තල ටරමනල එකක වවෘත කරගැනම පධොන ොමනව ොවත ොගොස පහත  
   ආකොරයට සද කළ හැකය. 
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Activities > System Tools > Terminal 

ඉහළට

8. root   යන කමක ද? 

රට(root)          යන ලනකස ොමොහයම පදධතොය සමපරණ පොලන හැකයොව ඇත ොමොහයම කරවොය(user). සරලව 
 පැවසොවොත රට(root)            ොලොගන එක භොවතො කරොමන ඔබට ලනකස ොමොහයම පදධතය තල ඔබට ඔනෑම 

   ොදයක කරමට හැකයොව ලැොබ.    අප ොමය සපර යසර(super user)  ොලසද හදනවනවො. 

ඉහළට

Hanthana Linux Project             Documentation Team
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